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1 Introduction

This documentation is designed to guide you through Quick Trial Balance Pro program, also referred to
as QTB Pro, and make learning the program as easy as possible. Directions for making full use of the
program are included in this manual.

A series of How To...? documents are included on most screens to provide information for the options
you are currently running in the program. These documents are in .pdf format and will walk you through
using most of the options contained in the program.

1.1 Splash Screen

When Quick Trial Balance Pro starts, the program's splash screen is displayed. The splash screen
contains the program's name and version, and copyright information. This screen can be suppressed by
selecting the option:

Show splash screen when Quick Trial Balance Pro starts?

This setting is located in the General section of the Preferences found in the Edit menu.

1.2 Product Activation Screen

After the initial installation of the program or if you are running the program in the Demo mode, the
Product Activation Screen appears. This screen will convert the software from a demo version to a full
version by entering the subscription code. This screen is displayed every time you start the program until
you enter the subscription code.

1.3 How To's

Most of the screens in Quick Trial balance Pro contain "How To...?" links that will display a .pdf file in
your default browser explaining details about the screen displayed and explanations how to use many of
the options available. 

1.4 Home Screen

The Home Screen is the control center for Quick Trial Balance Pro, serving as the point where you can
select any of the program's menu options. For your convenience, the Home Screen Toolbar is displayed
below the menu items allowing you to perform many of the most tasks at the click of a button. These
buttons represent shortcuts to the various menu options. Any button shown also has a corresponding
menu option that can also be selected from the Home Screen menu.
 
To select an option from the toolbar, simply click on the icon for the option you wish to perform. The
following options on the toolbar are described in order:

File Manager - Choose this option to access the File Manager where you can perform various file

options.

Open - Allows you to open an existing data file.

New - Allows you to create a new client data file.
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Backup - Allows you to make a backup or restore any (or all) of your data files.

Client Info - Allows you to display the Client Information Screen.

Accounts - This button displays the company's chart of accounts screen, which allows you to

select accounts for editing or viewing.

Trial Balance - This button displays the Visual Trial Balance screen, which allows you to select

an asset for editing or viewing.

Receipts - Allows you to enter cash receipts in the Cash Receipts Journal.

Checks - Allows you to enter checks in the Cash Disbursements Journal.

Journals - Allows you to post journal entries.

Reports - Clicking this item will take you to the list of reports available

Reset - Selects the Reset for New Year option.

Update - This option checks for the latest version of the program and updates it, if necessary.

Calculator - Clicking on this button displays a built-in calculator for you to use.

Help - This selection will display the entire Help for the program.

Exit - This button will close the program.

Client File Selected
The following information is displayed for the client file selected:

Company

File

Last Modified Date

Number of Accounts in File

Book Details

Quick Access
The following other options are available:

Favorite Reports - Select a favorite report from the list for this client and print, preview or

configure the report settings.

1.5 Main Menu

The Main menu contains all of the options available in the program. Across the top of the screen is the
menu that groups various options according to their function. The Main menu items are listed below:

File menu - These options contain the most common functions associated with client files,

general operation of the program, and a list of recently selected client files.

Edit menu - Common editing options and program Preferences can be found under this menu
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option.

Accounts menu - These menu items contain common functions associated with the maintenance

of the client's chart of accounts

Transactions menu - Options under this item are for cash receipts, disbursements, and journal

entries.

Reports menu - Reports and settings can be found under this menu item.

Housekeeping menu - Options that are less commonly used, including repair and yearly

maintenance, can be found here.

Help menu - General help information, tutorials, updating and activating the program, and contact

options for technical support are listed under this option.

 
Many of the more commonly used features can also be found as buttons on the toolbar located on the 
Home Screen.

1.6 Client File Selected

The following information is displayed on the Home Screen for the client file selected:

Company

File

Last Modified Date

Number of Accounts in File

Book Details

1.7 Quick Access

The Quick Access on the Home Screen gives you immediate access to the list of Favorite Reports. This
list can be manged by selecting the Favorite Reports option in the Reports menu. There you can add
reports that you print on a regular basis or delete reports that you don't print. The Preview, Print and
Configure Report buttons are located to the right of the report listed.

1.8 Form Re-sizing

Most of the screens can be re-sized to make them easier to read on your desktop or laptop monitor. To
re-size an individual screen, position the mouse pointer on the lower right corner of the screen, hold
down the mouse button and drag it at an angle to the lower right side of the screen to make it bigger or
drag it towards the center of the screen to make it smaller.

1.9 Menu Selections

When selecting an item from the menu, you can use the keyboard method of entering a hot-key as
displayed or underlined in the menu. Simply use the cursor-control (arrow) keys to highlight the option
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you want to select and press the enter key. Alternatively, you can use the mouse to click on any option
you want to select. The program will immediately respond to your selection.

1.10 Data Entry

When entering data into any of the fields or responding to prompts on the screen, you must press the
enter key to confirm your entry. The beginning of the data entry area begins after the prompt that
describes the information to be entered.

1.11 Entering Dates

Dates should be entered in the form of MM/DD/YY or MM/DD/YYYY where MM is a two-digit number for
the month, DD is a two-digit number for the day of the month, and YY or YYYY is a two or four digit
number for the year. While MM/DD/YY is by far the most common form of date entry in the program.

For added convenience, in most instances where dates are required, they can also be selected from a
drop-down calendar menu next to the date field.

1.12 Sorting Rules

There are a few sorting rules to remember when you are setting up clients and account numbers. All
numbers should be the same length (i.e., they should be padded with zero's and have the same number
of digits or characters. This will eliminate unexpected results when sorting or printing reports.
 
The following examples illustrate the right and wrong way to set up client account numbers. The first
example shows how a set of account numbers will be sorted if the numbers have different lengths.

If you enter numbers like this: Quick Trial Balance Pro sorts like this:

10 10

14 1000

20 14

30 140

140 20

1000 30

The second example shows the correct way to enter the same numbers using four digits for all Account
numbers numbers.

If you enter numbers like this: Quick Trial Balance Pro sorts like this:

0010 0010

0014 0014

0020 0020

0030 0030

0140 0140

1000 100
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Numbers and/or letters may be used in the account number field. However, it is important to note that
numbers always sort before letters.

1.13 Reports Printed to File

All reports can be printed or viewed  as .PDF files. Report files are normally saved in the Reports folder
of your default data folder, but the location and name assigned to the file can be changed when selecting
the print to file option. In addition, the report can be appended to an existing .pdf file or attached to an
email if the email settings are specified beforehand in the Preferences option in the Edit menu.

1.14 Technical Support

Technical support is included free with your annual subscription. Should you need assistance, you can
contact Pro-Ware using any of the following:

Email - support@proware-cpa.com

Voice:  (402) 861-8800 - Support hours are 8:30-5:00 p.m., CST

Fax:  (402) 861-8653 - 24 hours a day

Internet Web Site - www.proware-cpa.com
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2 File Menu

Options in the File menu pertain to creating, opening, and maintaining client data files.

To locate specific information for the various options, click the desired topic below:

File Manager - This option opens the client file list enabling you to select a file and perform basic

file maintenance operations.

New - This option guides you through the steps necessary to create a new client file.

Open - This option takes you to the client file listing where you can select a file for maintenance.

Open Recent - This option displays a list of the most recently selected files, allowing you to

quickly open them.

Save As... - This option allows you to make a copy of the client file selected. It can be saved to a

different folder or in the same folder with a different name.

Client Information - This option displays the Client Information Screen where you can make

changes to the company information for the selected client.

Backup / Restore - This option allows you to perform a backup or restore a backup file made

previously.

Manage - Options found under this item pertain to the various groupings of your chart of accounts

o Account Types - Select this option to add new groups or sub-groups to your file or edit

existing ones.

o Journals - This option allows you to add new journals or edit your existing journals.

o Payees - This option allows you to add, edit, or delete payees.

o Primary Groups - This option allows you to add, edit, or delete primary group codes.

o Secondary Groups - This option allows you to add, edit, or delete secondary group codes.

o Financial Statement Notes - This option allows you to enter and manage notes for the

client's financial statements

Import / Export - This option allows you to import groups from other client files or books within

your existing file.

Consolidate Trial Balances - This option allows you to view any consolidate files for the client

currently selected.

Close Window - This option closes the program.

Exit - This option closes the program.
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2.1 File Manager

This option can be selected from the File menu, the toolbar, or by pressing the CTRL + F keys, and
allows you to open a file or perform many other file operations by displaying the File Manager. From the
File Manager, either double-click the file you wish to select, or highlight the file in the list and then click
the Open button to open the company file.

The File Manager provides an easy way for you to access files by displaying additional information such
as the Company Name, year-end, and full path of the file. This information is automatically displayed
whenever you click the File Manager button found on the Home screen toolbar or by choosing the File
Manager option directly from the File menu. The File Manager is automatically populated with
information about all of the client files contained in your default data folder and any additional watched
folders when you start Quick Trial Balance Pro. The default data folder is specified in the Data Folder
section of the Preferences option, located under the Housekeeping menu or Edit menu and is the default
folder where any new files will be created. You can alternately specify additional folders by clicking the
Folders icon in the File Manager.
 
The File Manager contains the following information about each file:

Company Name

Year-End

Number of Books

Number of Accounts

Last Date Modified of the File

Path of the File Location

Entity Type

Tax ID of the Company

Some of the above information may not be visible when the File Manager screen is initially displayed;
however, you can use the horizontal scroll bar to view fields that aren't displayed. The columns can be
re-sized to fit or the screen can be re-sized to accommodate the width of the columns.

The currently selected file will be displayed in bold.

To open a company file, double-click on the file in the list or highlight the file and then click the Open
button and open the existing file.

Changing the sort order may make it easier to find a file or to see which files have been most recently
modified. To do this, click on the heading of the files listed in the grid. Clicking once puts the files in
ascending order (indicated with an arrow pointing up), while clicking twice puts the files in descending
order (indicated with an arrow pointing down).

The following section describes the other buttons in the file listing toolbar at the top of the screen or
listed under the File Menu for the File Manager.

Open Selected File - To open a file, highlight the file in the list and click Open Selected File.

Browse for Existing File... - Use the dialog box to navigate to the correct location, highlight the
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file and click Open or double-click the file to open it.

Add a New File... - Click to create a new data file, type the name of the new file and then click

the Save button.

Add an Existing File... - Choose this option to add a file to the File Manager that already exists

using the browse option.

Remove Selected File - Use this option to remove the selected file from the File Manager without

deleting it.

Delete Selected File - Use this option to remove the selected file from the File Manager and

delete it from disk.

Remove Missing Files - Use this option to remove any files in the File Manager without deleting

it.

Remove All Files from List - Choose this option to remove all files currently in the list. this

option does not delete the data files, only removes them from the listing.

Folders - Choose this option to add new folders that contain Quick Trial Balance Pro data files.

Refresh - Click this option to update the file listing, add new files, and remove missing files.

AutoFit - Clicking this button automatically re-sizes each column to accommodate the item with

the longest characters of data.

Locate - Choose this option to have Quick Trial Balance Pro search for files in any location on

your computer.

Save As - Choose this option to duplicate the file highlighted in the list.

Rename - Choose this option to rename the file highlighted in the list.

Show - Choose this option to show the highlighted in the folder where it resides.

Email - Choose this option to email the file highlighted in the list.

Print - Choose this option to print the File Listing Report.

2.1.1 Open Selected File

This option opens the highlighted file in the list. To open a file, highlight the file by clicking once on the
file in the list of files shown. Click the Open button and select the Open Selected File option to select
the file. The file can also be opened by double-clicking it in the list.

2.1.2 Browse for Existing File...

This option allows you to open a file that is not displayed in the list. Using this option, you can browse to
a specific location and select a file to open. Choose the Browse for Existing File... option by clicking on
the Open button. Navigate to the location where the file resides and then highlight the file and click Open
or double-click the file to open it. Once opened, the file is automatically added to the File Manager list.
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2.1.3 Add a New File...

This option will create a new file and add it to the File Manager automatically. When you select this
option a dialog box will appear that prompts you for a name for the new company file. Type in the name
of the new file and click Save to save the new file. Once the file is saved a box will appear that will allow
you to enter the Client Information for the company. 

2.1.4 Add an Existing File...

This option allows you to browse for and select an existing file to add to the file list. Once you choose
this option, a dialog box appears that allows you to navigate to the location where the file resides. Select
the file that you want to add to the list and click Open. Once the file is added to the list, you can select
the file by double-clicking it in the list or by highlighting the file and selecting the Open Selected File
option from the toolbar.

2.1.5 Remove Selected File

This option removes the highlighted file from the file list. If the file is located in your watched folders list,
you will be notified that it may be added back if you subsequently choose the Refresh option from the
toolbar of the File menu. This option only removes the file from the list and does not delete the client file
from the hard drive. The file can be added back to the list at anytime by choosing the Add an Existing
File... option or by running the Refresh option.

2.1.6 Delete Selected File

This option will delete the highlighted file from disk. Selecting this option will display a confirmation box
that confirms that you want to delete the file and remove it from the list. Click the Delete button to
confirm the deletion. Use this option with caution as there is no way to retrieve the file once it is deleted.

2.1.7 Remove Missing Files

This option will remove any missing files that cannot be found from the file list. Selecting this option will
scan all of the locations for which there are files listed and remove any files that cannot be found.
Normally this option is run if you move your data file location to another folder or remove files through
Windows Explorer or Mac OS Finder. You will be asked to confirm the removal when you select this
item. To remove the missing files, click the Remove button.

2.1.8 Remove All Files From List

This option removes all files from the list. This option will remove all files from the list. They can be added
back by clicking the Refresh button or added individually by choosing the Add an Existing File... option.

2.1.9 Folders

This option scans any folders that are currently in the Watched Folders list and allows you to add new
folders to the list or remove folders previously added from the list. In addition, you can designate any
folder as your default data folder and whether you want to include the sub-folders when scanning the
folder listed.

To add a new folder to the list of watched folders, click the + in the lower left of the window. Use the
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dialog box that appears to add a new folder by navigating to the new folder and clicking the select
button. You can create new folders to scan by clicking the "Make New Folder" button to create new
folders. Initially any new folders created here will not have data files in them until the files are moved
there using the Windows Explorer or the Mac OS Finder window or creating them in Quick Trial Balance
Pro.

2.1.10 Refresh

This option will refresh the information in the file list. Optionally, the box to remove missing files can be
checked to remove any missing files from the list. New files that are found are added automatically to
the list and any information listed is updated to reflect the most recent changes.

2.1.11 AutoFit

Clicking this button automatically re-sizes each column to accommodate the item with the longest
characters of data.

2.1.12 Locate

This option allows you to search a specified location for any data files. The default data location listed
will be searched automatically. To change this location, click the Change button and navigate to a new
location to search for data files.

If any files are found, you can click the "View List of Files" button to display the "Locate Files Report"
and print it, if desired. In addition, you can check the boxes to set the folder searched as the default and
add any data files the program finds to your file list.

2.1.13 Save As

This option allows you to make a copy of the highlighted file and save it under a different name. All
information is duplicated, including the chart of accounts and all balances. Once saved, you will be
asked if you want to select the new file. In addition, the file is automatically added to the list unless you
check the box to not add it to the list.

2.1.14 Rename

This option allows you to rename the highlighted file under a different name. You will receive a warning
message if you attempt to rename the file that you currently have selected. If you want to rename the file
you currently have selected, you must first select a different file. If you have no other files to select, you
should select the Save As option to duplicate your existing file.

2.1.15 Show

This option opens Windows Explorer or the Mac OS Finder Window to the specific location of the
highlighted file.

2.1.16 Email

This option allows you to attach the highlighted file to an email message. If you have not set up your
email information previously, you will have to set it up before you can use this option. You can enter your
email information in the Preferences option in the Edit menu or Housekeeping menu
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2.1.17 Print

This option allows you to print a listing of the files displayed in the list. Use the drop-down list to choose
the sorting option to sort by the path or the company name.

2.2 New...

To create a new client data file, select the New option from the toolbar or File menu or press Ctrl + N.
 
On the dialog screen that appears, type in the file name for the new company. You can also choose to
navigate to a different folder if you would like to create the file in a different location. By default, new
client data files are created in your default data folder designated in Preferences. in the Edit menu or
Housekeeping menu. Click the Save button to create the file. A message is displayed that will allow you
to begin entering the additional company information for the data file.

General Section
In the General section, enter the company name, year-end, tax id, entity type, and any additional notes
about the company. You can also limit access to the company file by clicking the appropriate box and
an alternate message to display when another user attempts to select this particular data file.

Books Section
In the Books section, choose the number of books (up to 3) for the company and the default book. The
following book types are supported:

Tax - Supports trial balance information to be used to prepare an income tax return

Book - Supports trial balance data to be used for financial statement preparation

Other - For a book type that does not fit the parameters of the previous book types listed above

Enter the description, type, and rounding option for each book.

Accounts Setup
Select the following account information

Account Length - Select the length of the account number field. (Min. 1, Max 20) for this

company

Account Format - Specify the format of the company's account number field. Click the "?" key

next to this field for details on how to specify formatting characters

Department Start and Length - If your account numbers contain department codes within them,

you can identify the start position and length of the department codes

Closing Accounts - Once you have created the Chart of Accounts, Closing Accounts can be

identified here. This button is disabled until accounts are added or imported to your file

Report Options
Select the following report options:

Do not print ZERO BALANCE accounts? - Suppresses printing accounts with no balances on
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the Working and Adjusted Trial Balance reports

Default sort order for trial balance reports and account listing - Choose the default sort order

when displaying accounts and printing certain reports

Default Report Memo - This appears on the heading of most reports and can be changed when

printing reports

Folders
Choose the default locations for additional documentation that you will add for your accounts and any
reports that you may print to disk.

Screen Prompts
Enter the Group Code Prompts and Prior Year Prompts that you would like displayed on account
listings, report configurations, and group code displays for this company.

Supporting Document
Choose the supporting documentation for the company's trial balance file. Additionally, the file can be
opened in it's native program by clicking the "Open Document" button. You can also click the "Open
Folder" button to open the folder containing the supporting document file.

2.3 Open...

To open a file, choose this option or click Open from the toolbar and then navigate to the correct folder,
highlight the file by clicking it, and then click Open to open a data file.

2.4 Open Recent

When selecting this item, you can select a data file from among the most recently accessed data files
listed. To remove the files in the list, go to the bottom of the list of files and choose the option Clear
Recent Files.

2.5 Save As...

This option allows you to save a file as another name and under the current directory or another
directory. If the data file is saved in a folder where a file with the same name currently resides, you will
be prompted to save the file under another name before it can be duplicated. This option can also be
found in the File Manager.
 

2.6 Client Information

The Client Information screen contains all of the basic company information for your client. The following
items are displayed on the left side of the screen and clicking the item shows the detailed information for
the client. This information can be edited at anytime.

General Section
This contains the company name, year-end, tax id, entity type, and additional notes about the company.
Access to this file can be limited by clicking the appropriate box. A message can also be displayed
when another user attempts to select the file.
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Books Section
This section contains the number of books (up to 3) for the company and the default book. The following
book types are supported in Quick Trial Balance Pro:

Tax - Supports trial balance information to be used to prepare an income tax return

Book - Supports trial balance data to be used for financial statement preparation

Other - For a book type that does not fit the parameters of the previous book types listed above

Optionally, rounding can be turned on or off for each book.

Accounts Setup
This section contains the following information about the company's chart of accounts:

Account Length - Length of the account number field. (Min. 1, Max 20) for the company.

Account Format - Format of the company's account number field. Click the "?" key next to this

field for details on how to specify formatting characters.

Department Start and Length - If the account numbers contain department codes within them,

the start position and length of the department codes can be identified.

Closing Accounts - This button identifies the company's closing accounts. This button is

disabled until accounts are added or imported to your file.

Report Options
The following report options are available:

Do not print ZERO BALANCE accounts? - Suppresses printing accounts with no balances on

the Working and Adjusted Trial Balance reports

Default sort order for trial balance reports and account listing - Choose the default sort order

when displaying accounts and printing certain reports

Default Report Memo - This appears on the heading of most reports and can be changed when

printing reports

Folders
This section contains the default locations for additional documentation that you may add for your
accounts and any reports that are printed to disk. There is also a utility to fix document links if the
documents are moved to a new folder location.

Screen Prompts
The Group Code Prompts and Prior Year Prompts can be changed in this section.

Supporting Document
This section contains the supporting documentation for the company's trial balance file. Additionally, the
file can be opened in it's native program by clicking the "Open Document" button. You can also click the
"Open Folder" button to open the folder containing the supporting document file.
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2.7 Backup / Restore

This option allows you to backup your data files or restore data files that have been previously backed-
up. You can backup the data file that is currently selected or all files in your data folder. If your data files
reside on a network, you should make sure that no one is using them otherwise backing-up or restoring
could cause irreparable damage to your data files.

Creating a backup
With the "Create Backup" option selected, choose whether you want to backup the one file or all of the
files in your data folder. If you want to backup the currently selected file, make sure that box is checked.
Choose the name of the backup file (a default name is chosen which incorporates the company, time
and date). Choose the desired location of the backup. There are several automatic options to choose
from or choose the "Custom Client Backup Folder" option to navigate to an alternate location.

Restoring data from a backup
Choose the "Restore data from backup" option and then select the backup file to restore. Note, that the
contents of the backup file can viewed by clicking the "View Backup File Contents" button. From there,
a specific data file can be selected to restore from a backup that contains multiple client files. Choose
where the file(s) are to be restored by selecting from the automatic options listed or choose the "Custom
Client Restore Folder" option to navigate to an alternate location. If the file you are restoring already
exists, you will be prompted to overwrite the existing file before proceeding. You can alter this behavior
by checking the box to overwrite without prompting.

Restoring from a Quick Backup
This option will search your default backup folder for any Quick Backups. A list will be displayed if any
are found and you can select the file to be restored. The most recent backups are displayed first. Files
that were previously backed up may be added to the list by clicking the "Add Backup Files" button.

2.8 Manage

The following items can be managed from here:

Account Types - Add or edit account types

Journals - Add, edit or delete journals

Payees - Add, edit, or delete payees

Primary Groups - Add, edit, or delete primary groups

Secondary Groups - Add, edit, or delete secondary groups

Financial Statement Notes - Add, edit, and delete financial statement notes as well as manage

the links

2.8.1 Account Types

Additional account types can be added using this option. Up to 9 account types can be added for each
of the standard types listed. The original account types cannot be changed, moved, or deleted.

To add a new account type click the " + " button in the lower left of the screen. Enter a new description
or add to the existing description. 
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2.8.2 Journals

This option allows you to add, edit or delete Journal Codes that can be used when entering cash
receipts, cash disbursements, and journal entries.
 
By creating journal codes, you can separate transactions based on different sources. For example, if
you want to enter cash disbursements from multiple bank accounts, you can create a separate journal
code for each bank account. This will allow you to enter and obtain report listings for each bank account.
 
You might also want to create a separate journal code for "passed" journal entries so that these can be
printed separately.
 
By default, the following three journal codes are automatically created for every client:

01 - Journal Entries

02 - Cash Receipts

03 - Cash Disbursements

Only the descriptions for these default journals can be edited and they can not be deleted. 

You will not be able to enter cash receipts or cash disbursements using the above journal codes until
you assign a bank account where the corresponding debit or credit will be made when entering
transactions. The cash accounts can be assigned by editing the journal and clicking the "Select
Account" button to assign a cash account where transaction will automatically be added to or
subtracted from when making entries.

2.8.3 Payees

This option allows you to add, edit, or delete payees. To add a payee, click the " + " button in the lower
right-hand corner of the screen. To delete a payee, highlight the payees and click the " - " button.

2.8.4 Primary Groups

This option allows you to add group codes that you want to assign to your chart of accounts so that you
can obtain grouped totals when printing the Grouped Trial Balance and other reports. Group codes can
also be added on-the-fly when you are using the Auto Assign Group Codes or the Auto Assign Sub-
Group  Codes options located in the Accounts menu. The following can be done using this option:

1. Add, change, re-order, import or delete group codes

2. Verify default codes

2. View other accounts with a particular group code

3. Print a listing of any group codes that have been created

To add a primary group, click the " + " button in the lower right-hand corner of the screen. To delete a
primary group, highlight the primary group and click the " - " button.

2.8.5 Secondary Groups

This option allows you to add secondary group codes that you want to assign to your chart of accounts
so that you can obtain secondary group totals on certain reports and financial statements. Secondary
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group codes can also be added on-the-fly when you are using the Auto Assign Secondary Group Codes
options located in the Accounts menu. The following can be done using this option:
 

1. Add, change, re-order, delete group codes

2. View other accounts with a particular group code

3. Print a listing of any group codes that have been created

To add a secondary group, click the " + " button in the lower right-hand corner of the screen. To delete a
secondary group, highlight the secondary group and click the " - " button.

2.8.6 Financial_Statement_Notes

This option allows you to add or mange any notes that you are including in your financial statements. To
add additional notes, click the " + " button, enter the title and note.

If you no longer need the note, it can be deleted by clicking the " - " button.

Edit the note by clicking the gear wheel and then clicking Edit...

The notes can be re-ordered using that option also located under the gear wheel.

All notes can be deleted by selecting that option under the gear wheel.

You can manage the links that link the notes to accounts, account types, and primary groups by
clicking the "Manage Links" button. Then choose the tab for account, account type, or primary group
and check the box for the specific item that you want to link to the note. The reference will be printed on
the financial statement next to account, account type, or primary group and the note will be printed in
the "Notes" section of the financial statements.

2.9 Import / Export

Use this option to:

Import chart of accounts and/or trial balances

Export chart of accounts and/or trial balances

Export data to Intuit Pro-Series

2.9.1 Import

This option allows you to import your chart of accounts and/or account balances from an external file.
Care should be taken when using this option since it assumes an understanding of external file types
and the ability to determine where the data resides in the external file. Using the options provided, you
can import from a variety of programs. Choose from among the following programs/formats:

QuickBooks - Trial Balance File

QuickBooks - Chart of Accounts File

Accoutnant's Trial Balance

WorkPaper's Plus

Trial Balance CS
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Go Systems Audit

Peachtree

Passport / Real World

Quick Trial Balance

Quick Trial Balance Pro

Custom Format

Based on the program/format you choose, you will be given the appropriate choice of file formats. Once
you select the program, the instructions can be viewed by clicking the "View Instructions" button.

Click the "Options" tab to choose the following additional options:

Delete all accounts before importing date?

Do not import account if it has a zero balance in the import file?

Import data into book 1 and/or book 2

The year-end for which you are importing data

Click the "File Locations" tab to choose the file to import.

2.9.2 Export

This option allows you to export your chart of accounts and trail balance data to an external file type.
Quick Trial Balance Pro data can be exported to to the following file types:

XLS File - Excel Spreadsheet file

XLSX File - Excel Spreadsheet file

CSV File - Comma Separated Values file

Under the File name and Folder tab, select the export file name and folder where you want the file saved.
There are buttons to simplify this process by setting the folder location automatically to either the
currently selected file's folder or the default data folder.

Under the Books / Fields to Export tab, select the books and the fields to export.

In the Accounts to Export tab, select all accounts, select a range of accounts, or use the Custom Filter
option to select the specific accounts to export.

Under the Sort Order tab, choose the sort order for the export file.

You can save these export settings by clicking the "Save Export" button. Once you have saved the
settings, they can be restored by clicking the "Restore Export" button. Multiple different exports can be
saved and recalled at any time.
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2.9.3 Export for ProSeries

This option will create an external file to be linked to a ProSeries tax file. Each time you create an
external file for ProSeries, it is recommended that you verify the data that is linked in ProSeries is
correct. To create a file to link to ProSeries, perform the following:

Enter the file name and folder where the file will be created. Choose the groups and books to export.
There is also an option to include accounts with beginning balance sheet balances. This step is normally
only necessary for new clients that have never had prior year returns in ProSeries. Every year when the
data is converted through the ProSeries Transfer option, the prior year data is normally converted.

2.10 Consolidate Trial Balances

This option will allow you to consolidate any of your client data files into one consolidated file. Simply
choose a name and location for the consolidated file and then select the files to consolidate by clicking
the "Add" button and choosing the files from the list that appears. A warning will appear if the files have
different year-end dates.

2.11 Close Window

Select this option to exit the program.

2.12 Exit

Select this option to exit the program.
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3 Edit Menu

The Edit menu contains various functions that are useful when editing in various places int he program.
The following functions, including the associated hot-keys, are included in the Edit menu:

Undo (Ctrl + Z) - This option will undo the previous edit change.

Cut( Ctrl + X) - This option will cut the selected text and temporarily paste it to the clipboard.

Copy (Ctrl + C) - This option will copy the selected text and temporarily paste it to the clipboard.

Paste (CTRL + V) - his option will insert the clipboard contents where your cursor is located.

Delete - This option will delete the highlighted text.

Select All (Ctrl + A) - This option will select the entire contents of a field.

Preferences (Ctrl + ,) - This option allows you to change any of the program's preferences.

These functions are only available where applicable. If a function is not available, it will be disabled.

3.1 Preferences

The program's Preferences option allows you to make changes to the program's current
configuration.The preferences can also be found in the Housekeeping menu. The following sections are
listed on the left hand side with corresponding preferences options that can be changed in the program:
 

General Preferences

Require password when starting this application

Ask for confirmation when exiting Quick Trial Balance Pro

Show splash screen when Quick Trial Balance Pro starts

Open new windows stacked over front-most window

Restore "Do not show again" messages 

Change password option

Data Folder

Default Data Folder - Click the folder to navigate to a new default data folder. If you change your

default data folder and one or more of the following folders do not existe, you will be prompted to

create them automatically:

o Backups

o Reports

o SampleData

o Documents

o Pictures

File Manager 
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Show File Manager when the program starts (or open the last selected data file)

Show file locations in the recent files menu

Refresh the File Manager every time it is opened (Check for new and missing files)

Use alternating colors in the File Manager list

Show grid lines in the File Manager list

Email

Use default email client provided by my system

Use built-in email client (requires configuration) - SMTP (mail) servers can be added in the

program

The following information must be added to use Quick Trial Balance Pro's built-in mail

client:

o Description

o SMTP Server Address

o Port

o Check if authentication is required

o Username for authentication

o Password for authentication

o The password can be displayed by clicking the Show Password button

o Test the settings entered for your SMTP Server by clicking the Test Settings... button

Software Updates 

Check for updates - Choose the frequency to check for updates by clicking the drop-down list.

Advanced Options - Click "Advanced Options" to select location, alternate update server, proxy

server and alternate user account profiles. It is recommended that you contact your network

administrator before making any changes.

Reports 

Include alternate line shading on those reports that allow it? - Choose alternate line shading

for reports

Use landscape vs. portrait when printing reports? - Selecting this option choose Landscape as

the default when printing reports.

Display report configuration screen when report is checked? - This option display the report

configuration screen when selecting a report.

In Windows, preview reports using the built-in pdf viewer? - Remove the check from this box
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to use Widows default pdf viewer.

In Windows, run the built-in pdf viewer from the program install folder? - Check this box to

run the viewer from the install folder.

Prompt for printer when printing reports? - Checking this box displays the printer dialog before

printing.

Separate multiple reports into separate print jobs? - Check this option to print each report in a

batch to a separate file.

Report line spacing (1, 1.5, or 2) - Choose the default line spacing for reports.

Financial Statement Font Size - Choose the font size (5 - 10 points) when printing financial

statements.

Manage Favorite reports - Click the Favorite Reports button to add or remove reports from the

Favorites list.
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4 Accounts Menu

The following options are available in the Accounts menu:

Accounts Listing - Displays listing where accounts can be added or deleted and account details

can be changed.

Visual Trial Balance - Displays the Quick Trial balance Pro's visual trial balance.

Quick Entry Balances - Allows you to quickly enter beginning and prior year balances to the

chart of accounts.

Quick Entry Workpaper Refs - Allows you to quickly enter workpaper reference numbers to the

chart of accounts.

Auto Assign - Automatically assign, account types, primary or secondary groups.

4.1 Accounts Listing

Choosing this option will display the entire chart of accounts. From the Accounts Listing tab you can
perform the following:

Add - Add accounts to your file

Edit - Edit accounts to your file

Delete - Delete existing accounts

Previous - Go to the previous account

Next - Go to the next account

Print - Print a listing of the accounts

Re-Order - Reorder the accounts

Home - Return to the Home screen

To view the account details click the Account Details tab.  You can view balances, group codes,
documents associated with an account, or notes about the account by clicking the specified tab.

4.2 Visual Trial Balance

The Visual Trial Balance button is located on the Home screen toolbar. By selecting this option, your
entire trial balance will be displayed in a grid similar to a spreadsheet. All the information for your trial
balance is contained in this screen; the account number, account name, work paper reference number,
memo balance, trial balance, adjustments, and adjusted trial balance.

From this screen you can do any of the following:

View data from any of the books you have setup for the client

Display comparative data for current and any prior years

View account details including group codes
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Add new or edit existing accounts

Add new or edit existing journal entries

Generate journal entries

Reset the client file for the new year

Print the Working Trial Balance

You can optionally set a filter for the accounts listed by account name, account type, or any groups that
have been entered for the client file.

4.3 Quick Entry Balances

This option allows you to enter beginning and/or prior year balances for your chart of accounts.
 
At the top of the Quick Entry screen, there are drop down combo boxes that allow you to select the
book that you want to enter beginning balances, or prior year balances, and the year. These will default
to the first book in your file and the current year. If you select a prior year, the current year balances will
be displayed just below the field where you enter your balances to serve as a reference when entering
your data.
 
The accounts numbers will be displayed in the section below the combo boxes where you can enter the
beginning or prior year balances. There are also buttons to create new accounts (on the fly) or edit the
account information.

You can also use the "Copy Balances" feature to copy balances from another book in your file. Copy the
beginning balance of a different book, trial balance amounts (after cash transactions, but before journal
entries), or adjusted trial balance amounts.
 
You can navigate through your accounts by pressing any of the following characters:
 

N - Next account

P - Previous account

F - First account in your file

L - Last account in your file

 
Separate fields are provided to enter debit or credit balances, however, you will always be positioned in
the debit field first. If you leave it blank, you are then moved to the credit field. If you leave the credit field
blank, the program assumes you do not want to enter a beginning balance and moves automatically to
the next account in the list.
 
At the bottom of the screen, the income, or loss, is updated and displayed as you enter your balances.

4.4 Quick Entry Workpaper Refs

This option is used to enter workpaper reference numbers. Separate reference numbers can be entered
for each book you are maintaining.
 
Workpaper reference numbers are printed on the following reports.
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Working Trial Balance

Lead Schedules

Adjusted Trial Balance

4.5 Auto Assign

The following can be automatically assigned:

Account Types - Automatically assign account types to the chart of accounts

Primary Group Codes - Automatically assign primary group codes to the chart of accounts

Secondary Group Codes - Automatically assign secondary codes to the chart of accounts

4.5.1 Account Types

This option is used to assign "account types" to your chart of accounts. Account types are used to
identify the type of account, asset, liability, equity, income, expense, etc. the account represents. This
allows the program to calculate income and/or loss for the balance sheet and income statement
separately. If an account has not been assigned an account type, it will be grouped with the balance
sheet accounts and could result in an incorrect calculation of income or loss for your books.

The account types that you assign to your accounts are the same all books in a data file. So if you are
maintaining two books, income tax and financial statements, and you assign the "Current Asset"
account type to one of your accounts, it will be considered a current asset no matter which book you
generate a report with.
 
The Assign Types screen is separated into three sections.
 

Account Selection
This section allows you to select accounts that you want to view in the grid. Accounts in the grid are
accounts that are affected when you select an account type to assign. You have the flexibility of
assigning all accounts or a range of accounts using the look-up buttons provided. You can also enter a
keyword that will be used to select accounts that will be added to the grid. For example, if you entered
"supplies", all accounts with the word "supplies" in it will be added to the grid.
 

Assignment Grid
The assignment grid shows the accounts that can be affected by your assignments.  However, before
they can be affected, you will need to mark the check box for all accounts you want affected.  There are
buttons below the grid to "mark all" or "clear all" the check boxes of the accounts in the grid.
 

Assignment Section
The assignment section is where you select an account type from the drop down combo box and then
click the Assign button to assign the account type to the accounts in the grid.  Only accounts that are
marked will be assigned the account type you select.
 
You can very quickly assign account types using this option even if you have hundreds of accounts in
your file.
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4.5.2 Primary Group Codes

This option is used to assign Group Codes to your accounts. Group Codes are used when printing the
Grouped Trial Balance. Accounts that are assigned the same Group Code are added together so that
they can be reported as one amount.
 
Overview
You can assign up to 10 group codes to each account number. This allows you to use one group code
to summarize your accounts to prepare the income tax return and a different group code to summarize
your accounts to prepare your financial statements.
 
Group Codes appear on the Chart of Accounts Add / Edit screen. You can also change the screen
prompts that appear on the Add / Edit screen in the Client Information Screen.
 
Codes Assigned to Group Codes
The codes you assign can either be created by you, selected from ones that you previously created,
imported from another client's group codes, imported from another group's group codes, or imported from
codes that are included with Quick Trial Balance Pro and are mapped to the lines on various tax returns.

Codes are assigned to your accounts by selecting them from a list of available group codes that you can
either create on-the-fly, setup a head of time, or import from another group code or from some group
codes. It is important to understand that each of the 10 group codes that you can assign to each
account are selected from an available list that is unique to each of the 10 group codes. In other words,
you can select from one list of group codes for your Tax Group Code and another completely different list
for your Financial Statement Group Code.

Import Group Codes
To make it easier to re-use Group Codes, you can:

Import codes from those setup for another group code in the current file

Import codes from those setup for a group code in another QTB data file

Import codes from those included with QTB that map to line numbers on various income

tax returns

Those group codes, included with QTB, will assist you in preparing the following income tax returns:

IRS Form 1040 - Schedule C - Profit and Loss from Business

IRS Form 1040 - Schedule E - Supplemental Income and Loss

IRS Form 1040 - Schedule F - Cash Schedule for Profit and Loss from Farming

IRS Form 1065 - US Return of Partnership Income

IRS Form 1120 - US Corporation Income Tax Return

IRS Form 1120S - US Income Tax Return for an S Corporation

To import any of the above mentioned group codes, use the Import option under the Group submenu in
the File Menu.
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Assign Group Codes Screen Layout
When you select this option to assign group codes, you will be presented with a screen that allows you
to select the GROUP CODE that you want to assign a new or previously used group code.  Note that If
you changed the screen prompts for your group codes, these will be displayed in the drop down list of
group codes.  After selecting a group code, the Assign Group Codes screen will be displayed.

The Assign Group Codes screen is separated into three sections and is very similar to the Assign Types
screen.

Account Selection
This section allows you to select accounts that you want to view in the grid.  Accounts in the grid will be
the only accounts that are affected when you select an group code to assign.  You have the flexibility of
assigning all accounts or a range of accounts using the lookup buttons provided.  You can also enter a
keyword that will be used to select accounts that will be added to the grid.         For example, if you
entered "supplies", all accounts with the word "supplies" in it will be added to the grid.

Assignment Grid
The assignment grid shows the accounts that can be affected by your assignments.  However, before
they can be affected, you will need to mark the check box for all accounts you want affected.  There are
buttons below the grid to "mark all" or "clear all" the check boxes of the accounts in the grid.

Assignment Section
The assignment section is where you create new group codes or select from existing group codes and
then click the Assign button to assign the group code to the accounts in the grid.  Only accounts that
are marked will be assigned the group code you select.  You can also use the Remove button to remove
group codes that were assigned to accounts.

Included Group Codes
To facilitate preparation of various types of income tax returns, we include some group code sets that
you can use to assign to your accounts instead of creating your own.  Before these can be used to
assign to your accounts, you need to import them into your Group Codes File.  To do this, select the 
Import option from the Groups submenu in the File Menu.

In addition to assigning Group Codes, you can also assign Sub-Group Codes.  To see an explanation of
when to use Sub-Group codes and how to assign them, see the section Assign Sub-Group Codes.

After assigning your group codes, you can print the Grouped Accounts Listing to review your group code
assignments.

When you are satisfied with your group code assignments, you can print the Grouped Trial Balance
report to obtain the grouped totals needed to prepare your income tax returns or financial statements.

4.5.3 Secondary Group Codes

This option allows you to assign Sub-Group codes to accounts that were assigned the same Group
Code.
 
To explain when you might want to use Group and Sub-Group codes, we will refer to Group codes as
PRIMARY codes and Sub-Group codes as SECONDARY group codes.  Using the example of preparing
an income tax return, if you need a total for Cost of Goods Sold, you would assign a primary Group
Code to all accounts that will be added together to arrived at Cost of Goods Sold.  However, you may
also need to group accounts together to get a schedule of the accounts included in Cost of Goods Sold.
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Listed below are some accounts that would ALL be assigned a primary group code of "COGS" to
represent that they should be added together to get a total for cost of goods sold.  Shown next to each
account is the sub-group code that would be assigned to them to obtain grouped totals to prepare a
schedule showing the details for accounts included in cost of goods sold.  Accounts that are not
assigned a sub-group code would be shown as a separate amount on the sub-group schedule.

Account Sub-Group Code

Purchases Purchases

Inventory Change Purchases

Labor Supplies

Depr. - Equipment Depreciation

Depr. - Building Depreciation

Taxes - Payroll Taxes

Taxes - Property Taxes

The Assign Sub-Group Codes screen is separated into three sections and is very similar to the Assign
Group Codes screen.

Account Selection
This section allows you to select accounts that you want to view in the grid.  Accounts in the grid will be
the only accounts that are affected when you select a group code to assign.  First, select an Account
Group that you want to work with.  Then select the primary group that you want to assign sub-group
codes to.  Then click the Add to Grid button to add all accounts with that primary group code to the grid.

Assignment Grid
The assignment grid shows the accounts that can be affected by your assignments.  However, before
they can be affected, you will need to mark the check box for all accounts you want affected.  There are
buttons below the grid to "mark all" or "clear all" the check boxes of the accounts in the grid.

Assignment Section
The assignment section is where you create new sub-group codes or select from existing sub-group
codes and then click the Assign button to assign the sub-group code to the accounts in the grid.  Only
accounts that are marked will be assigned the sub-group code you select.  You can also use the
Remove button to remove sub-group codes that were assigned to accounts.
 
After assigning your sub-group codes, you can print the Grouped Accounts Listing to review your group
code assignments.

When printing the Grouped Trial Balance, if sub-group codes are assigned to your accounts, a sub-group
schedule will be printed for each primary group that contains secondary group codes.
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5 Transactions Menu

Options listed in the Transactions Menu enable you to enter the various transactions that your client has
during the year. The types of transactions you can enter are listed below:

Cash Receipts - Enter all cash receipts transactions here

Cash Disbursements - Enter all cash disbursements using this selection.

Journal Entries - Enter any other types of adjustment for journal entries here.

5.1 Journal Entries

This option allows you to enter journal entries to adjust your trial balance. Select the journal code for the
journal entry to be entered. Journal codes are created in the Manage, Journals option in the File menu.
The ability to create multiple journal codes allows you to create, for example, a journal code for "passed"
journal entries that will not be posted so that you can obtain a list of all the passed entries. Passed
journal entries are those that are not posted because they are not material to the overall financial
position of the company.

After the journal code is identified, you can do the following:

Add, edit or delete journal entries

Go to the previous or next journal entry

Print a list of the journal entries

View the details for each entry by clicking on the Details tab

Search for a specific journal entry

5.2 Cash Receipts

This option allows you to enter cash receipts that will affect the trial balance. 

After the cash receipt account is identified, you can do the following:

Add, edit or delete cash receipts

Go to the previous or next cash receipts

Print a list of the cash receipts

View the details for each cash receipt by clicking on the Details tab

Search for a specific cash receipt

5.3 Cash Disbursements

This option allows you to enter cash disbursements that will affect the trial balance. 

After the cash disbursement account is identified, you can do the following:
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Add, edit or delete cash disbursement

Go to the previous or next cash disbursement

Print a list of the cash disbursement

View the details for each cash disbursement by clicking on the Details tab

Search for a specific cash disbursement
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6 Reports Menu

The following options are available in the Reports menu:

QTB Reports - Choose any combination of reports to print or preview

Financial Statements - Create fully customizable financial statements

Manage Favorite Reports - Add or delete reports in the Favorite Reports listing on the Home

screen

6.1 QTB Reports

Choosing this option displays a list of all reports available in the program.

Each report has its own settings that you can configure using the "Configure Settings" button. You can
print, preview, or save any of the reports by clicking the respective buttons in either the QTB Reports
screen or under each report's Configure Settings screen.

6.1.1 General Reports

This group displays the General Reports contained in the program.

6.1.1.1 Chart of Accounts

This report will print a complete listing of all the accounts entered in the data file. It will also show the
beginning balances for any of the books you have in your file.

Two reports will be printed; one for the balance sheet accounts and one for the income statement
accounts. The account types determine which report an account will be included on.

6.1.1.2 Beginning / Prior Year Balances

This report will print a report showing the beginning or prior year balances. If you select a prior year
balance to print, you can optionally elect to have the current year balances printed with the period you
select.

The differences between this report and the Chart of Accounts Report is that this report does not include
the account types and the Chart of Accounts Report will only include current year balances.

6.1.1.3 Grouped Accounts Listing

This report will print a list of the accounts and the group code and sub-group codes that have been
assigned to the accounts.

6.1.1.4 Primary / Secondary Groups Listing

This report prints a list of groups and sub-groups that have been assigned to your accounts. One of the
unique things about this report is that instead of showing the accounts that each group or sub-group
code was assigned to, it shows how many accounts each code has been assigned to.
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6.1.1.5 Journals Listing

This report will print a list of journals that have been created using the Journals option in the File Menu.

6.1.1.6 Account Documents

This report will identify any supporting documents that you have assigned to your chart of accounts. In
addition, you can print any notes you have entered that are associated with each document. You can
also specify to print just the accounts that have supporting documents assigned or print the entire listing
of accounts whether or not they have a supporting document assigned.

6.1.2 Trial Balances

This group displays the Trial Balance reports contained in the program.

6.1.2.1 Working Trial Balance

The working trial balance is generally printed to determine what year-end procedures you want to perform
on various accounts. This is the report you would print after entering, or importing, your beginning
balances. If any adjustments have been made, these will be reflected on the working trial balance report.

6.1.2.2 Lead Schedules

This report prints an account listing based on the account types previously created for your client.You
can select from any of the books that are contained within the client's data file.

6.1.2.3 Journal Entries Listing

This report contains a list of all journal entries entered. You have the option of print all journal entries or
journal entries for a specific journal code.

6.1.2.4 Adjusted Trial Balance

The adjusted trial balance report is generally printed after all adjustments have been entered. The prior
year balance is also included on this report for reference purposes.

6.1.2.5 Grouped Trial Balance

The grouped trial balance is used to obtain grouped totals based on the account group selected. If sub-
groups have been entered for any of the primary groups, these will also be printed as a separate
schedule.

6.1.2.6 Grouped Accounts Detail Report

The Grouped Accounts Detail Report will print a detailed listing of accounts and balances contained for
each group.

6.1.2.7 Comparative Group Trial Balance

This report consists of two different reports, a grouped trial balance report and a group codes report for
the primary and secondary group codes that you can select for the report. The amounts and differences
are shown for the year-end selected and the prior year.
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6.1.2.8 Trial Balance Comparison Report

The Trial Balance Comparison Report allows you to print a report that will compare trial balance
amounts. You can select trial balance from the same period to compare different books, or select trial
balance from different periods to compare the same book, or any combination of the two.

6.1.3 Financial Statement Reports

This group displays the financial statement reports contained in the program.

6.1.3.1 Proforma Financial Statements

This report will print a formal balance sheet or income statement for your client. There are various
options to select when printing these financial statement reports which provide a format that will easily
serve as part of a financial statement compilation.

6.1.4 Transaction Reports

This group displays the Transaction Reports contained in the program.

6.1.4.1 Cash Disbursements Listing

This report contains a list of all cash disbursements entered. You have the option of print all cash
disbursements or disbursements for a specific journal code.

6.1.4.2 Cash Receipts Listing

This report contains a list of all cash receipts entered. You have the option of print all cash
disbursements or disbursements for a specific journal code.

6.1.4.3 General Ledger

The general ledger shows all the activity that has transpired during the year, such as, journal entries,
cash receipts, and cash disbursements. This will be particularly useful if you are entering cash receipts
and disbursements.

6.1.5 Analysis Reports

This group displays the Analysis Reports contained in the program.

6.1.5.1 Account Comparision Report

This report will compare the following:

Balance Sheet Accounts

Income Statement Accounts

Specific Account Types

Specific Account Groups

You can select the number of years to compare and which year end to begin with.
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In addition, you can select from two different formats:

Two Year Comparison - Current and prior year on the same line.

Multiple Year Comparison - Prints each year on a separate line.

You can elect to show group totals.

6.1.5.2 Expense Account Analysis

This report is useful for analyzing changes in expense accounts compared to changes in revenues.
 
On this report, all revenue accounts (account type = Income - All) will be grouped together and the
change between the current year and prior year is shown in both dollars and percentages.
 
All expense accounts (account type = Expense - All) are printed and the dollar and percentage change
is also calculated for each account; thereby, allowing you to compare the changes in certain expense
accounts with the change in revenues.

6.2 Financial Statements

This option allows you to create fully customizable financial statements. To add a custom financial
statement, click the "+" button at the bottom of the screen.

The custom financial statement options screen appears. You can enter or change the following for the
custom financial report you are printing:

Name - You can name the financial statement report you are creating

Year - Choose the year for which to print the report and whether to include prior year data

Book - Choose the book to be used for the financial statements

Group Code - Choose the Group Code to use when printing the financial statements

Report Memo - Choose an option report memo to print on the headings of each report

Group by department - Choose to print separate financial statements for each department

identified in the Client Information screen

Round to whole dollars - Choose to print financial statements with rounded numbers

Left-Justify subtotal headings - Choose to left-justify all subtotal headings

Use Group Code to Summarize Data - Choose to use group codes to summarize data

Print landscape - Choose to print the report using landscape orientation

Sections to print - Check the reports to be included when printing this financial statement. The

following reports can be selected for printing:

o Cover Page - Choose option to include or exclude page numbering, what page to start, and

whether to exclude the page from the table of contents

o Contents Page - Choose option to include or exclude page numbering, what page to start,
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and whether to exclude the page from the table of contents

o Accountant's Report - Choose option to include or exclude page numbering, what page to

start, and whether to exclude the page from the table of contents, the title of the Accountant's

Report to be printed and what information is to be included in the body of the report

o Balance Sheet - Choose option to include or exclude page numbering, what page to start,

whether to exclude the page from the table of contents, and the two-page or one-page format

to print

o Income Statement - Choose option to include or exclude page numbering, what page to start,

whether to exclude the page from the table of contents, and option to print the detail format

o Cash Flow Statement - Choose option to include or exclude page numbering, what page to

start and whether to exclude the page from the table of contents

o Notes - Choose option to include or exclude page numbering, what page to start, whether to

exclude the page from the table of contents, and whether to print the actual note references

on the financial statements

o Supporting Schedules - Choose option to include or exclude page numbering, what page to

start, whether to exclude the page from the table of contents, and option to include a

separator page, whether to include revenue detail or not and the text to print for the separator

page

In addition, you can use the up and down arrows to change the order in which move the reports will be
printed.

Click the "Save" button to save the settings for the financial statement.

Choose the "Reset Settings" button to reset the financial statement settings to the default settings.

Click the "PDF" button to choose the the various options for saving, appending and attaching the
financial statements to an email.

Click the "Preview" or "Print" buttons to preview or print the report.

To delete any financial statements previously created, click the " - " button located in the lower-left of the
screen.

To change any settings used for previously created financial statements, delete all of the financial
statements previously created or import the financial statement settings previously created for another
client, click the gear to the lower-left of the screen and choose the appropriate option. You can also click
the "Change Settings" button to change any of the financial statement settings previously saved.

Click the "Edit Notes" button to add or edit any notes for this client. You can add, delete, or change
existing notes by clicking the " + ", " - ", or gear buttons at the lower-left of the screen. Once you add a
new note or edit an existing note, clcik the "Save" button to save your changes. 

Once you have entered notes, you can manage how the notes are linked in the file. To do this, click the
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"Manage Links" button. You can choose whether to print the note for specific account, account type, or
for a Primary Group. Check the box next to the item that you want referenced in the financial statement.
You can also choose to always print with the financial statements or to only print the note if it is linked
to an account or group. 

6.3 Manage Favorite Reports

This option allows you to add or delete reports to the Favorite Reports listed on the Home screen.
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7 Housekeeping Menu

The Housekeeping Menu contains the following options that are normally run on an infrequent basis:

Reset for the New Year - This option will reset your client file to the next year.

Rebuild Index Files - This option rebuilds the index files which may have become corrupted or

invalid due to an import or other cause.

Fix Options - The various options found under "Fix" provide a way for you to repair or alter various

settings in your existing database.

o Re-post Journal Entries - This option will re-post any journal entries in your client's file.

o Re-post Cash Transactions - This option will re-post any cash transactions in your client's

file.

o Remove Workpaper Reference Numbers - This option will remove all workpaper references

from any accounts and books in your file.

Unreset to Prior Year - This option will set your client file back to the previous year.

Convert Quick Trial Balance Files - This option allows you to convert files from prior versions of

Quick Trial Balance.

7.1 Preferences

The Preferences option allows you to make changes to the program's current configuration. The 
Preferences can also be found in the Edit menu. The following sections are listed on the left hand side
with corresponding preferences options that can be changed in the program:
 

General Preferences

Require password when starting this application

Ask for confirmation when exiting Quick Trial Balance Pro

Show splash screen when Quick Trial Balance Pro starts

Open new windows stacked over front-most window

Restore "Do not show again" messages 

Change password option

Data Folder

Default Data Folder - Click the folder to navigate to a new default data folder. If you change your

default data folder and one or more of the following folders do not existe, you will be prompted to

create them automatically:

o Backups

o Reports
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o Sample Data

o Documents

o Pictures

File Manager 

Show File Manager when the program starts (or open the last selected data file)

Show file locations in the recent files menu

Refresh the File Manager every time it is opened (Check for new and missing files)

Use alternating colors in the File Manager list

Show grid lines in the File Manager list

Email

Use default email client provided by my system

Use built-in email client (requires configuration) - SMTP (mail) servers can be added in the

program

The following information must be added to use Quick Trial Balance Pro's built-in mail

client:

o Description

o SMTP Server Address

o Port

o Check if authentication is required

o User name for authentication

o Password for authentication

o The password can be displayed by clicking the Show Password button

o Test the settings entered for your SMTP Server by clicking the Test Settings... button

Software Updates 

Check for updates - Choose the frequency to check for updates by clicking the drop-down list.

Advanced Options - Choose advanced options for updates including update locations, alternate

update server, proxy server and alternate user account profiles. It is recommended that you

contact your network administrator before making any changes.

Reports 

Include alternate line shading on those reports that allow it? - Choose alternate line shading

for reports
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Use landscape vs. portrait when printing reports? - Selecting this option choose Landscape as

the default when printing reports.

Display report configuration screen when report is checked? - This option display the report

configuration screen when selecting a report.

In Windows, preview reports using the built-in pdf viewer? - Uncheck to use Widows default

pdf viewer.

In Windows, run the built-in pdf viewer from the program install folder? - Check this box to

run the viewer from the install folder.

Prompt for printer when printing reports? - Checking this box displays the printer dialog before

printing.

Separate multiple reports into separate print jobs? - Check this option to print each report in a

batch to a separate file.

Report line spacing (1, 1.5, or 2) - Choose the default line spacing for reports.

Financial Statement Font Size - Choose the font size (5 - 10 points) when printing financial

statements.

Manage Favorite reports - Click the Favorite Reports button to add or remove reports from the

Favorites list.

7.2 Reset for New Year

This option is used to prepare your file for the next's year activity. It removes all cash transactions and 
journal entries and moves the adjusted trial balance to the prior year balance field.

Once the file has been backed up, you can select from the following options before resetting the file for
the new year:

Add additional or change existing Profit and loss closing accounts 

Select journal entries to archive

Choose whether to move ending balances to beginning balances for balance sheet

accounts

Choose whether to remove workpaper reference numbers from all accounts and books

During the Reset option, all of your previous journal entries will be archived for later use. This is
especially helpful if you have multiple recurring entries that you make for a client each year. Now these
previous entries can be recalled when entering journal entries for the next year.

Click on the link at the bottom of the Reset window to see a list of everything that happens during the
reset process.
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7.3 UnReset to Prior Year

This option allows you to select a prior year file that has been backed up during the Reset for New Year.
When the Reset for New Year is performed, a automatic backup of your file is created within the
program. When you select this option, you can select any of the prior year backup files that were
originally created during the Reset for New Year and return to a prior period.
 
It is important to note that any changes made in a prior period file are not automatically carried over to
any subsequent period's file. You may have to change the beginning balances in subsequent years
depending on the changes made in the prior year files.

7.4 Rebuild Indexes

Should you encounter any problems sorting your chart of accounts, printing any reports or navigating
through your file, it may be necessary to run this option.

7.5 Fix

The Fix options for the program are listed as follows:

Re-Post Journal Entries - This option re-posts any journal entries in your client's file.

Re-Post Cash Transactions - This option re-posts any cash transactions in your client's file.

Remove Workpaper Reference Numbers - Removes any workpaper reference numbers

7.5.1 Repost Journal Entries

This option is provided so that you can repost all journal entries if needed.

7.5.2 Repost Cash Transactions

This option is provided so that you can repost all cash transactions if needed.

7.5.3 Remove Workpaper Reference Numbers

This option allows you to remove all workpaper reference numbers from any accounts and books in your
file. Use this option with caution as there is now way to recover from the workpaper references other than
restoring a previous backup.

7.6 Convert Quick trial Balance Files

This option will convert Quick Trial Balance files from prior versions (6 and prior) of the program. To
convert a file (or multiple files) simply click the folder and navigate to the location which contains your
QTB data files.

You can select from one of two options when converting your data files. By default any converted files
will be saved to the default data folder specified in the Data Folder section of the Preferences found in
the Edit menu. However, you can choose the option to save the converted data files to the same folder
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where your current data files are stored. Alternatively, you can click the folder icon to navigate to a
different folder in which to save the converted data files.

Once you navigate to the location of the prior version data files by clicking the folder icon, all files in that
location will appear in the list. Next to each file, you can elect whether to convert the file and if the file
has already been converted, you can check the box to overwrite it. Use care when selecting to overwrite
the existing data because if you have already converted your file, it will be overwritten automatically when
you select this option.

If you want to selectively convert or overwrite existing files, you can clear all the boxes underneath the
convert option by clicking the Clear Convert button. Then, you can click the Convert box for only selected
files. Click the Overwrite All button to check all of the Overwrite boxes for your files.

If you click the More Options button, you will find options for converting prior year files, including files
found in sub-folders, and deleting the conversion log prior to converting any data files.
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8 Help Menu

The following options are available in the Help menu:

About Quick Trial Balance Pro - Displays information about the installed version of Quick Trial

Balance Pro.

Help - Opens Quick Trial Balance Pro's .html help in your default browser.

Learning Resources - Displays various learning resources available in for the program.

Feedback - Allows you to enter any feedback in a message box that is automatically emailed to

Pro-Ware's technical support.

Activate - If you are using Quick Trial Balance Pro in the Demo mode, this option allows you to

enter subscription codes after purchasing the program and receiving confirmation from Pro-Ware.

Update - Automatically check for updates to the program from Pro-Ware's website.

Calculator - Enables the system calculator.

8.1 About Quick Trial Balance Pro

The information contained on this screen contains the version and date of the program you are running. It
may be necessary to access this information while on the phone with Pro-Ware's technical support in
order for us to verify that you are running the latest version. Here you will find other useful items such as
the phone and fax numbers and email address with which to contact Pro-Ware, LLC's technical and
customer support. You will also find Pro-Ware's web site address, which you can access as needed for
important bulletins and the latest updates for Quick Trial Balance Pro.

By clicking the System Information button, a screen is displayed showing information about your
computer and environment. In the Folders tab, the location of the application installation, configuration,
data, backup, and reports folder are displayed. Under the Reset Options tab, the Report Favorites and
Window Positions can be reset to their defaults. To test the speed of the network versus your local drive
or remote folders, choose the Benchmark tab. You can navigate to various locations and then test the
speeds of each.

8.2 Help

The Help option opens Quick Trial Balance Pro's .html help file in your default internet browser. It
provides detailed information for all of the options found in the program. You may print any portion of the
Help file contents for future reference.

8.3 Learning Resources

The following learning resources requiring an internet connection are available:

Frequently Asked Questions - Displays Answers to questions that you may have about the

program.
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QTB Pro Webpage - Click this link to view information from the website.

How - To's - Click to see a list of step-by-step instruction about most of the features in the

program.

Version History - This link contains a detailed chronological list of enhancements and bug fixes.

View Help as PDF - View the entire Help file in your default PDF viewer.

The following learning resources that do not require an internet connection are also available:

Conversion Guide - Displays detailed instructions for converting files from a prior version of Quick

Trial Balance.

What's New - This guide shows information about new features and recent changes.

8.4 Feedback

Selecting this option displays the Feedback screen. Please feel free to fill in this form with any
comments, questions, or suggestions you may have about Quick Trial Balance Pro. You may then email
the information directly to Pro-Ware's technical support. In addition, you can include a copy of your data
file if there is something that requires analysis by our staff. A button to attach an additional file is also
included if there is a PDF file, spreadsheet, etc. that may help in analyzing your data.

We continually strive to make Quick Trial Balance Pro a better program. This is done primarily through
the comments and suggestions made by you, the user. Every form that is submitted to us is evaluated
for its merits and whenever practical, a change or enhancement is made to the program.

8.5 Activate

This option is used to enter your serial number, company name, and subscription code to activate Quick
Trial Balance Pro after your purchase. The subscription code is emailed to you when you purchase the
program. You can also obtain the subscription code by calling Pro-Ware.

If you are using the demo, you can place an order on line by clicking the "How to Order" button.

8.6 Update

This option checks for the most current update for Quick Trial Balance Pro on the Pro-Ware website. If
there is a newer version available, you will be given the option of updating or postponing the update to a
later time. Updating the program normally requires internet access. Updating options can be changed in
the Preferences option found under the Edit menu.

8.7 Calculator

When the Help menu is displayed, you can select this option to display the standard calculator. You
can also click the Calculator button on the Home screen to display the calculator.
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The built-in calculator fully supports the cut, copy, and paste functions supported by your operating
system. The keyboard shortcuts in Windows are CTRL + C for copy, CTRL + X for cut and CTRL + V for
paste. The Mac OS supports these same keys by using the command (Apple) key.
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